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1. Vigtigt

1.	 Vigtigt
Denne elektroniske brugervejledning er beregnet 
til alle, der bruger Philips-skærmen. Tag den tid du 
behøver for at læse vejledningen, inden du bruger 
skærmen. Den indeholder vigtige oplysninger om 
bemærkninger angående brugen af din skærm.

Philips garanti dækker under forudsætning af, 
at produktet behandles korrekt og anvendes til 
det tilsigtede formål i overensstemmelse med 
dens brugervejledning, og ved forevisning af den 
originale faktura eller kvittering med angivelse af 
købsdatoen, forhandlerens navn samt model og 
produktionsnummer for produktet.

1.1	 Sikkerhedsforanstaltninger og 
vedligeholdelse

	 Advarsler
Anvendelse af betjeningselementer, justeringer 
eller fremgangsmåder, der ikke er beskrevet i 
denne dokumentation, kan resultere i elektrisk 
stød, elektriske ulykker og/eller mekaniske ulykker.
Læs og følg disse vejledninger, når du tilslutter 
og anvender din computerskærm:

Betjening:
•	 Hold skærmen væk fra direkte sollys, 

meget kraftige lyskilder såvel som andre 
varmekilder Længerevarende udsættelse 
for denne slags forhold kan medføre 
misfarvning og beskadigelse af skærmen.

•	 Fjern alt, der kan risikere at falde i 
ventilationsåbningerne eller forhindre 
korrekt afkøling af skærmens’ elektronik.

•	 Bloker ikke ventilationsåbningerne på 
kabinettet.

•	 Under placering af skærmen skal du sikre 
dig, at det er let at komme til strømstikket 
og stikkontakten.

•	 Hvis der slukkes for skærmen ved at fjerne 
strømkablet eller jævnstrømsledningen, 
skal du vente 6 sekunder, før du sætter 
strømkablet eller jævnstrømsledningen til 
igen for at opnå normal betjening.

•	 Brug altid et godkendt strømkabel, der 
er leveret af Philips. Hvis du mangler dit 
strømkabel, skal du kontakte dit lokale 
servicecenter. (Se Informationscenter for 
kundepleje)

•	 Udsæt ikke skærmen for kraftige 
vibrationer eller stød under anvendelse.

•	 Slå ikke på skærmen, og undgå at tabe den 
under brug eller transport.

Vedligeholdelse:
•	 Som en beskyttelse af skærmen skal du 

undgå at trykke kraftigt på LCD skærmen. 
Når du flytter din skærm, så tag fat 
om rammen for at løfte den. Løft ikke 
skærmen ved at sætte din hånd eller fingre 
på LCD skærmen.

•	 Tag stikket ud fra skærmen, hvis du ikke 
skal bruge den i en længere periode.

•	 Tag stikket ud at kontakten til skærmen, 
hvis du skal rengøre den med en let fugtet 
klud. Skærmen kan tørres af med en tør 
klud, når der er slukket for strømmen. 
Under alle omstændigheder, må der ikke 
bruges organiske opløsningsmidler til 
rengøring af din skærm.

•	 For at undgå risiko for elektrisk stød eller 
permanent beskadigelse af anlægget, må 
du ikke udsætte skærmen for støv, regn, 
vand eller miljøer med høj fugtighed.

•	 Hvis din skæm bliver våd, skal den tørres 
af med en tør klud så hurtigt som muligt.

•	 Hvis der kommer fremmed substans eller 
vand ind i skærmen, så sluk straks for 
strømmen og tag stikker ud. Fjern derefter 
den fremmede substans eller vandet, og 
send skærmen til servicecenteret.

•	 Skærmen må ikke bruges eller opbevares 
på steder, hvor den udsættes for varme, 
direkte sollys eller ekstrem kulde.

•	 For at opretholde den bedste ydelse 
af din skærm og for langvarig brug, 
bedes du bruge skærmen et sted, der 
er indenfor følgende temperatur- og 
fugtighedsområde.
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•	 Temperatur: 0-40 °C 32-95 °F
•	 Fugtighed: 20-80 % RH

Vigtige oplysninger vedrørende 
fastbrændinger/spøgelsesbilleder på skærmen
•	 Sørg altid for at aktivere en pauseskærm, 

der bevæger sig, når skærmen efterlades 
uden at blive anvendt. Du skal altid bruge 
en pauseskærm eller et andet program, 
der opdaterer skærmen regelmæssigt, hvis 
skærmen viser statisk materiale i længere 
perioder. Uafbrudt visning af stille eller 
statiske billeder over en længere periode 
kan forårsage, at billedet "brændes fast" på 
skærmen, dvs. de såkaldte "efterbilleder" 
eller "spøgelsesbilleder" på din skærm.
"Fastbrænding", "efterbilleder" og 
"spøgelsesbilleder" er velkendte fænomener 
inden for LCD teknologien. I de fleste tilfælde 
vil "brandmærkerne" eller "efterbilledet" eller 
"spøgelsesbilledet" forsvinde gradvist, efter 
skærmen er blevet slukket.

	 Advarsel
Hvis der ikke bruges en pauseskærm eller et 
program, der opdaterer skærmen periodisk, kan 
der opstå alvorlige tilfælde af "fastbrændinger" 
eller "efterbilledet" eller "spøgelsesbilleder", som 
ikke forsvinder, og som heller ikke kan repareres. 
Ovennævnte skade er ikke dækket af garantien.

Service
•	 Kabinettet må kun åbnes af kvalificeret 

servicepersonale.
•	 Hvis der er behov for et dokument til 

reparation eller integration, så kontakt 
dit lokale servicecenter. (Se kapitlet om 
"Kundeinformationscenter")

•	 For oplysninger om transport, se "Tekniske 
specifikationer".

•	 Efterlad ikke din skærm i en bil/bagagerum 
under direkte sollys.

	 Bemærk
Kontakt en servicetekniker, hvis skærmen ikke 
fungerer korrekt, eller hvis du er usikker på, hvad 
du skal gøre, når betjeningsinstruktionerne, der 
er givet i denne manual, er fulgt.

1.2	 Notationsbeskrivelser
Følgende underafsnit beskriver de 
notationsmæssige konventioner, der benyttes i 
dette dokument.

Bemærkninger, forholdssregler og advarsler
I hele denne vejledning kan tekstafsnit være 
ledsaget af et ikon, og stå med fed eller kursiv 
skrift. Disse afsnit indeholder bemærkninger og 
punkter, hvor der skal udvises forsigtighed, eller 
advarsler. De anvendes som følger :

	 Bemærk
Dette ikon angiver vigtige oplysninger og 
tips, hvormed du kan gøre bedre brug af 
computersystemet.

	 Forsigtig
Dette ikon angiver oplysninger om, hvordan du 
undgår risiko for skader på hardwaren eller tab 
af data.

	 Advarsel
Dette ikon angiver risiko for personskader, og 
hvordan dette undgås.
Visse advarsler kan optræde i andre formater, og 
er eventuelt ikke ledsaget af et ikon. I sådanne 
tilfælde er den givne udformning af advarslen 
lovmæssigt obligatorisk.
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1.3	 Bortskaffelse af produkt og 
emballage

Elskrot WEEE (Waste Electrical and Electronic 
Equipment)

This marking on the product or on its 
packaging illustrates that, under European 
Directive 2012/19/EU governing used electrical 
and electronic appliances, this product may 
not be disposed of with normal household 
waste. You are responsible for disposal of 
this equipment through a designated waste 
electrical and electronic equipment collection. 
To determine the locations for dropping off 
such waste electrical and electronic, contact 
your local government office, the waste disposal 
organization that serves your household or the 
store at which you purchased the product.

Your new monitor contains materials that can 
be recycled and reused. Specialized companies 
can recycle your product to increase the 
amount of reusable materials and to minimize 
the amount to be disposed of. 

All redundant packing material has been 
omitted. We have done our utmost to make the 
packaging easily separable into mono materials.

Please find out about the local regulations on 
how to dispose of your old monitor and packing 
from your sales representative. 

Taking back/Recycling Information for 
Customers

Philips establishes technically and economically 
viable objectives to optimize the environmental 
performance of the organization's product, 
service and activities.

From the planning, design and production 
stages, Philips emphasizes the important of 
making products that can easily be recycled.  At 
Philips, end-of-life management primarily entails 
participation in national take-back initiatives 
and recycling programs whenever possible, 
preferably in cooperation with competitors, 
which recycle all materials (products and related 
packaging material) in accordance with all 
Environmental Laws and taking back program 
with the contractor company.  

Your display is manufactured with high quality 
materials and components which can be 
recycled and reused.

To learn more about our recycling program 
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page

http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
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2.	 Opsætning af skærm

2.1	 Installation

	 Emballagens indhold
￼

* Depends on the country

273V5Register your product and get support at

www.philips.com/welcome

Quick

Start

2013

使用产品前请阅读使用说明

保留备用

user s manual

* DVI

* VGA
* Audio

Power

* Afhænger af landet
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2. Opsætning af skærm

	 Installation af stander
1.	 Anbring skærmen med forsiden vendt 

nedad på en blød og jævn overflade, 
og vær forsigtig med ikke at ridse eller 
beskadige skærmen.

2.	 Fastgør fodsøjlen med skærmen indtil den 
klikker på plads.

3.	 Hold på skærmens stander med begge 
hænder, og sæt med en fast hånd standeren 
ind i fodsøjlen.

	 Tilslutning til PC

273V5QHAB/273V5QHABP

5
6

6

7

1 	 AC strømindgang
2 	 HDMI indgang
3 	 DVI-D-indgang
4 	 VGA-indgang
5 	 Lyd-indgang
6 	 Høretelefonstik
7 	 Kensington anti-tyverisikring

273V5LHSB

5

1 	 AC strømindgang
2 	 VGA-indgang
3 	 HDMI indgang
4 	 HDMI lydudgang
5 	 Kensington anti-tyverisikring

273V5LSB/273V5QSB/273V5QSBP/273V5QS
W/273V5QSWP/273V5LSW

	 AC-strømindgang
	 DVI-D-indgang
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	 VGA-indgang
	 Kensington anti-tyverisikring

273V5LHAB

5
6

5

7

1 	 AC strømindgang
2 	 HDMI indgang
3 	 DVI-D-indgang
4 	 VGA-indgang
5 	 Lyd-indgang
6 	 Høretelefonstik
7 	 Kensington anti-tyverisikring

273V5LYAB

5
6

5 7

1 	 AC strømindgang
2 	 Lyd-indgang
3 	 DP indgang
4 	 DVI-D-indgang
5 	 VGA-indgang
6 	 Høretelefonstik
7 	 Kensington anti-tyverisikring

Tilslutning til pc
1.	 Tilslut ledningen ordentligt pa bagsiden af 

skærmen.
2.	 Sluk for computeren og tag netledningen 

ud af stikket.
3.	 Slut skærmens signalkabel til videostikket 

bag på computeren.
4.	 Sæt computerens og skærmens 

netledninger til et stik i nærheden.
5.	 Tænd for computeren og skærmen. Hvis skærmen 

viser et billede, er installationen gennemført.

2.2	 Brug af skærm

	 Produktbeskrivelse set forfra

Modeller 273V5QHAB/273V5QHABP/273V5LH
AB/273V5LYAB

5

6 2347

Modeller 273V5LSB/273V5QSB/273V5QSBP/2
73V5QSW/273V5QSWP/273V5LSW/

273V5LHSB

5

6 2347

Tænder og slukker for skærmen.
Sådan får du adgang til OSD-
menuen.
Bekræft justering i skærmmenuen.
Gå tilbage til det forrige OSD-
niveau.

Justerer lysstyrkeniveau.

Til justering i skærmmenuen.

Juster lydstyrken.

Skifter visningsformat.
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Automatisk justere skærmen.

	 Beskrivelse af OSD-skærm

Hvad er OSD (On-Screen Display)?
Visning på skærmen On-Screen Display 
(OSD) er en funktion på alle Philips LCD 
skærme. Den sætter en slutbruger i stand 
til at justere skærmindstillingerne, eller 
vælge skærmens funktioner direkte via et 
instruktionsvindue på skærmen. Et brugervenligt 
skærmvisningsinterface vises som nedenfor:

Modeller 273V5LSB/273V5QSB/273V5QSBP/2
73V5QSW/273V5QSWP/273V5LSW:












 

Modeller 273V5LYAB:

















Modeller 273V5LHSB














Modeller 273V5LHAB

















Modeller 273V5QHAB/273V5QHABP

















Grundlæggende og enkle anvisninger til 
kontrolknapperne
I skærmmenuen ovenfor, kan du bruge  
 knapperne foran på skærmen til at flytte 

markøren med, og tryk på OK knappen, til at 
bekræfte dit valg eller ændring.
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OSD-menuen
Nedenstående er en generel oversigt over 
strukturen i OSD-displayet. Du kan anvende 
den som opslag, når du senere skal orientere dig 
i de forskellige justeringer.

Main menu Sub menu

Picture
Wide Screen, 4:3
0~100

0~100

Picture Format
Brightness

Contrast
Off, Fast, Faster, FastestSmartResponse

OSD 
Settings

0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

Horizontal

Vertical

Transparency

OSD Time Out

Setup

0~100

On, Off

Yes, No

0~100

0~100

0~100

H. Position

Auto

V. Position

Phase

Clock

Resolution 
Notification

Reset

Information

Language English Español, Français, Deutsch, Italiano,

Português, Русский 简体中文, Türkçe, 

Color 6500K, 9300K

Red: 0~100
Green: 0~100
Blue: 0~100

Color Temperature
sRGB

User Define

Audio
0~100

On, Off

Volume

Mute

(available for selective models)

(available for selective models)

Audio In, HDMI, DisplayPortAudio Source

VGA

HDMI
DisplayPort

Input

On, OffSmartContrast
On, OffPixel Orbiting

DVI

On, OffOver Scan

(1.8, 2.0, 2.2, 2.4, 2.6)Gamma
(available for selective models)

Nederlands, Svenska, Suomi, Polski, Čeština

한국어, 日本語, Maryar, Українська, 

Português do Brazil,  Ελληνική (προαιρετικός),   
繁體中文(可選) 

	 Meddelelse om opløsning
Denne skærm er fremstillet til optimal ydelse 
på dens native opløsning, som er 1920 x 1080 
ved 60 Hz. Når skærmen bruger en anden 
opløsning, ses følgende advarsel på skærmen: 
Use 1920 × 1080 @ 60 Hz for best results (Brug 
1920 x 1080 ved 60 Hz for at opnå det bedste 
resultat).

Advarslen vedrørende den naturlige opløsning 
kan deaktiveres under Installation i OSD 
(skærmmenuen).

	 Fysisk funktion

Vip
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2.3	 Fjern standeren og foden

	 Fjernelse af foden
Inden du begynder at adskille skærmens fod, skal 
du følge vejledningerne nedenfor for at undgå 
mulig beskadigelse eller personskade.

1.	 Anbring skærmen med forsiden vendt 
nedad på en jævn overflade, og vær 
forsigtig med ikke at ridse eller beskadige 
skærmen.

2.	 Tryk på låseklemmerne for at fjerne foden 
fra søjlen.

1

3.	 Tryk på udløserknappen for at afmontere 
foden.

2

	 Bemærk
Denne skærm accepterer et 100 x 100 mm 
monteringsinterface.

100mm

100mm

	 Forsigtig
Kun til brug med UL-godkendte vægbeslag med 
minimum vægt/belastning på 3,5 kg 
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Windows7/8 kompatibel, og klar til at forbedre 
din oplevelse med Philips-skærme!

	 Installation
•	 Følg instruktionen og fuldfør installationen.
•	 Du kan starte, når installationen er fuldført.
•	 Hvis du vil begynde senere, kan du klikke 

på genvejen på skrivebordet eller på 
værktøjslinjen.

Opstartsguide
•	 Efter installation af SmartControl Lite 

starter guiden automatisk, når du åbner 
programmet første gang.

•	 Guiden leder dig trin for trin gennem 
indstillingen af skærmen.

•	 Du kan også gå til Plug-in menuen, for at 
starte guiden på et senere tidspunkt.

•	 I Standard-vinduet kan du indstille flere 
funktioner uden brug af guiden.

3.	 Billedoptimering

3.1	 SmartContrast

	 Hvad er dette?
Unik teknologi, der dynamisk analyserer det 
viste indhold, og automatisk optimerer LCD 
skærmens kontrastforhold til maksimal visuel 
klarhed. Den øger baggrundsbelysningen og 
giver et klarere, friskere og lysere billede eller 
dæmper baggrundsbelysningen med henblik 
på en tydelig visning af billeder på en mørk 
baggrund.

	 Hvorfor behøver jeg det?
Du ønsker den allerbedste visuelle klarhed 
og visning på enhvert indhold. Smart-kontrast 
styrer den dynamiske kontrast og indstiller 
baggrundslyset, så det giver klare, friske og 
lyse spil- og videobilleder, samt viser en 
tydelig, læsbar tekst ved kontorarbejde. Ved at 
nedsætte skærmens strømforbrug, sparer du 
energiomkostninger og forlænger skærmens 
levetid.

	 Hvordan virker det?
Når du aktiverer SmartContrast, analyseres 
det viste indhold i realtid, og farver og 
baggrundslysets intensitet indstilles. Denne 
funktion forbedrer den dynamiske kontrast og 
giver således en bedre underholdningsoplevelse, 
når du ser videoer eller spiller spil.

Philips SmartControl Lite
Det nye SmartControl Lite-software fra Phillips 
giver dig mulighed for at kontrollere skærmen 
via et nemt, grafisk interface. Komplicerede 
justeringer hører fortiden til. Dette 
brugervenlige software guider dig gennem 
finindstilling af opløsning, kalibrering af farve, 
justering af clockning/fase, RGB-hvidpunkt osv.

Dette iøjefaldende, ikon-baseret software er 
udstyret med den seneste teknologi i algoritmer 
for hurtig behandling og reaktion, og er tilmed 
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	 Start med Standard-vinduet:

Adjust (Indstillings) menuen:
•	 Med Adjust (Indstillings) menuen kan du 

indstille Brightness (Lysstyrken), Contrast 
(Kontrast), Focus (Fokus), Position (Position) 
og Resolution (Opløsning).

•	 Udfør indstillingen ved at følge 
instruktionerne.

•	 Installationen kan annulleres med Annuller.
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Color (Farve) menuen:
•	 Med Color (Farve) menuen kan du 

indstille RGB, Black Level (Sortniveau), 
White Point (Hvidpunkt), Color Calibration 
(Farvekalibrering).

•	 Udfør indstillingen ved at følge 
instruktionerne.

•	 Se nedenstående oversigt med 
undermenupunkter baseret på din 
indtastning.

•	 Eksempel på Color Calibration 
(Farvekalibrering):
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1.	 "Show Me" (Vis Mig) starter vejledningen til 
farvekalibrering.

2.	 Start – starter en 6-trins farvekalibreringssekvens.
3.	 Quick View (Hurtigvisning) indlæser før/

efter-billederne.
4.	 For at vende tilbage til farve vinduet, skal 

du klikke på Cancel (Annuller).
5.	 Aktiver farvekalibrering - der som standard er 

aktiveret. Hvis markeringen er fjernet, kan du ikke 
udføre en farvekalibrering, ligesom Start- og Quick 
View (Hurtigvisning) knapperne er gråtonede.

6.	 Der skal være patentoplysninger på 
kalibreringsskærmen.

Første farvekalibreringsskærm:

•	 Previous (Foregående) knappen er deaktiveret, 
indtil du går videre til den anden farveskærm.

•	 Next (Næste) går til efterfølgende mål 
(seks mål).

•	 Gå til sidst til File>Presets pane 
(Fil>Forudindstil)-vindue.

•	 Cancel (Annuller) lukker UI og vender 
tilbage til Plug-in siden.

Options > Preferences (Funktioner > 
Indstillinger) - er kun aktiv, når Preferences 
(Indstillinger) er valgt i Options (Funktioner)-
rullemenuen. På en ikke-understøttet skærm 
med DDC/Ci er kun Help (Hjælp) og Options 
(Funktioner) til rådighed.

•	 Viser nuværende, foretrukne indstillinger.
•	 Funktionen aktiveres ved at afmærke feltet. 

Afmærkningsfeltet er en flip-flop.
•	 Enable Context Menu (Aktiver Indhold 

menuen) er som standard afmærket (Til) på 
skrivebordet. Enable Context Menu (Aktiver 
Indhold menuen) viser valgmulighederne 
i SmartControl Lite på Select Preset 
(Vælg Forvalg) og Tune Display (Indstil 
Display) i genvejmenuen ved at højreklikke 
på skrivebordet. Deaktiveret fjerner 
SmartControl Lite fra genvejsmenuen.

•	 Enable Task Tray (Aktiver Jobbakke) 
menuen er som standard afmærket (Til) 
på skrivebordet. Menuen Aktiver Indhold 
gør, at systembakkens ikon til SmartControl 
Lite vises. Et højreklik på jobbakke-ikonen 
viser menufunktionerne for Help (Hjælp), 
Technical Support (Teknisk Support), Check 
for Update (Tjek for opdateringer), About 
(Om) og Exit (Afslut). Når Enable Task Tray 
(Aktiver Jobbakke) menuen er deaktiveret, 
viser jobbakke-ikonen kun Exit (Afslut).

•	 Run at Startup (Kør ved opstart) er 
som standard afmærket (Til). Når den 
er deaktiveret, starter SmartControl Lite 
ikke ved opstart og ikonet vises ikke i 
systembakken. SmartControl Lite kan kun 
startes fra genvejen på skrivebordet eller fra 
programfilen. Intet forvalg, som er indstillet til 
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at køre ved opstart, indlæses når denne boks 
ikke er afmærket (er deaktiveret).

•	 Aktivér gennemsigtighedstilstand 
(Windows7/8, Vista, XP). Standard er 0% 
uigennemsigtighed.

Options > Input (Funktioner > Indgang) 
- er kun aktiv, når Input (Indgang) er valgt i 
Options (Funktioner) rullemenuen. På en ikke-
understøttet skærm med DDC/Ci er kun Help 
(Hjælp) og Options (Funktioner) til rådighed. 
Alle andre faneblade i SmartControl Lite er ikke 
til rådighed.

•	 Vis Source (Kilde) instruktionsvinduet og 
nuværende indgangskildeindstillinger.

•	 På enkeltindgangsskærme ses dette vindue 
ikke.

Options > Audio (Funktioner > Lyd) - er 
kun aktiv, når Audio (Lyd) er valgt i Options 
(Funktioner) rullemenuen.

På en ikke-understøttet skærm med DDC/Ci 
er kun Help (Hjælp) og Options (Funktioner) til 
rådighed.

Help > User Manual (Hjælp > 
Brugervejledning) - er kun aktiv, når User 
Manual (Brugervejledning) er valgt i Help (Hjælp) 
rullemenuen. På en ikke-understøttet skærm 
med DDC/Ci er kun Help (Hjælp) og Options 
(Funktioner) til rådighed.

Help > Version (Hjælp > Version) - er kun aktiv, 
når Version (Version) er valgt i Help (Hjælp) 
rullemenuen. På en ikke-understøttet skærm 
med DDC/Ci er kun Help (Hjælp) og Options 
(Funktioner) til rådighed.
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Context Sensitive Menu (Indholdssensitiv menuen)
Context Sensitive Menu (Indholdssensitiv 
menuen) er som standard aktiveret. Hvis 
Enable Context Menu (Aktiver Indholdssensitiv 
menuen) er afmærket i Options > Preferences 
(Funktioner > Indstillinger) vinduet, ses menuen.

Context Menu (Indholdmenuen) har fire punkter
•	 SmartControl Lite - når valgt, ses Om 

skærmen.
•	 Select Preset (Vælg Forvalgt) – herefter 

vises en hierakisk menu med gemte forvalg, 
der straks kan bruges. En afkrydsning viser 
det nuværende valgte forvalg. Factory 
Preset (Fabriksforvalg) kan også hentes i 
rullemenuen.

•	 Tune Display (Indstil Skærm) - åbner 
kontrolpanelet til SmartControl Lite.

Jobbakke menu aktiveret
Menuen i systembakken kan ses ved at 
højreklikke på SmartControl Lite-ikonet 

i systembakken. Et venstreklik starter 
programmet.

Jobbakken har fem punkter:
•	 Help (Hjælp) - adgang til 

brugervejledningsfilen: Åbner 
Brugervejledningen med standard 
browservinduet.

•	 Technical Support (Teknisk Support) - viser 
siden med teknisk support.

•	 Check for Update (Tjek for opdateringer) 
- leder brugeren til PDI Landing og tjekker 
brugerens version i forhold til den nyeste 
version.

•	 About (Om) - viser detaljerede 
referenceoplysninger : Produktversion, 
udgivelsesinformation og produktnavn.

•	 Exit (Afslut) - Luk SmartControl Lite.
Hvis du vil køre SmartControl Lite igen, skal 
du enten vælge SmartControl Lite i Program 
menuen, dobbeltklikke på skrivebordet eller 
genstarte systemet.

￼

Jobbakke menu deaktiveret
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Når Jobbakke er deaktiveret i indstillinger-
mappen, er kun Exit (Afslut) valgmuligheden til 
rådighed. Hvis du helt vil fjerne SmartControl 
Lite fra systembakken, skal du deaktivere Run 
at Startup (Kør ved opstart) i Options > 
Preferences (Muligheder > Indstillinger).

	 Bemærk
Alle billederne i dette afsnit er kun til referenece. 
SmartControl-softwareversionen kan ændres 
uden varsel. Kontroller venligst den officielle 
portræt-hjemmesiden www.portrait.com/dtune/
phl/enu/index, for at downloade den seneste 
version af SmartControl softwaret.

www.portrait.com/dtune/phl/enu/index
www.portrait.com/dtune/phl/enu/index
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4.	 Tekniske specifikationer
Billede/Skærm
Skærmpaneltype TN-LCD(273V5L);MVA LCD(273V5Q)
Baggrundslys LED
Panelstørrelse 27'' W (68,6 cm)
Billedforhold 16:9
Pixel pitch 0,311 × 0,311 mm
Lysstyrke 300 cd/m²
SmartContrast 10.000.000:1
Kontrastforhold (typ.) 1000:1 / 3000:1 (273V5QHAB/273V5QSB/273V5QSW)

Reaktionstid (typ.) 5ms / 12ms(273V5QHAB/273V5QSB/273V5QSW) / 15ms(273V5
QHABP/273V5QSBP/273V5QSWP)

Smart Response
4 ms (GtG) (273V5QHAB/273V5QSB/273V5QSW)
5 ms (GtG) (273V5QHABP/273V5QSBP/273V5QSWP)
1 ms (GtG) (273V5LHAB/273V5LHSB)

Optimal opløsning 1920 x 1080 ved 60Hz.

Synsvinkel
170° (H) / 160° (V) ved C/R > 10;
178° (H) / 178° (V) ved C/R > 10 (273V5QHAB/273V5QHABP/
273V5QSB/273V5QSBP/273V5QSW/273V5QSWP)

Skærmfarver 16,7 M
Vertikal opdateringshastighed 56Hz - 76Hz
Horisontal frekvens 30kHz - 83kHz
sRGB JA
Tilslutningsmuligheder

Inputsignal

VGA,DVI(273V5LSB/273V5QSB/273V5QSBP/273V5QSW/273V5
QSWP/273V5LSW/273V5LYAB/273V5LHAB/273V5QHAB/273V5
QHABP),HDMI(273V5LHAB/273V5LHSB/273V5QHAB/273V5Q
HABP),DP(273V5LYAB)

Inputsignal Separat synk., synk. på grøn

Audio In/Out

Pc-lydindgang (273V5LYAB/273V5QHAB/273V5QHABP/273V5LH
AB),
hovedtelefonstik (273V5QHAB/273V5QHABP/273V5LHAB/273V
5LYAB),
HDMI lydudgang (273V5LHSB)

Behagelighed
Indbyggede højttalere 2W × 2 (273V5QHAB/273V5QHABP/273V5LHAB/273V5LYAB)

Brugerfunktioner

273V5LSB/273V5QSB/273V5QSBP/273V5QSW/273V5QSWP/27
3V5LSW/273V5LHSB:

273V5QHAB/273V5QHABP/273V5LHAB/273V5LYAB:
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Billede/Skærm

OSD sprog

Engelsk, fransk, tysk, spansk, italiensk, russisk,
Forenklet kinesisk, portugisisk, tyrkisk, hollandsk, svensk, finsk, polsk, 
tjekkisk, koreanske, japanske, Ungarn, Ukraine, Brasilien portugisiske 
og græsk (kan udelades), traditionel kinesisk (kan udelades) 

Andre funktioner Kensington-lås
"Plug and Play" kompatibilitet DDC/CI, sRGB, Windows 8/7, Mac OSX, Linux
Fod
Vip -5 / +20

273V5LHSB/273V5LHAB/273V5QHAB/273V5QHABP
Strøm

Tændt-tilstand

273V5LHSB: 29,1 W (typ.), 34,26 W (maks.),
273V5LHAB: 27,19 W (typ.), 34,84 W (maks.),
273V5QHAB: 40,74 W (typ.), 47,59 W (maks.),
273V5QHABP: 25,49W (typ.), 28,18 W (maks.)

I dvale (Standby) 0,5W
Fra 0,3W
Strømdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)
Strømforsyning Indbygget, 100-240 VAC, 50/60 Hz

273V5LSB/273V5QSB/273V5QSBP/273V5QSW/273V5QSWP/273V5LSW/273V5LYAB
Strøm

Tændt-tilstand

273V5LSB/273V5LSW: 32,53 W (typ.), 33,95 W (maks.)
273V5LYAB: 25,05 W (typ.), 35,3 W (maks.)
273V5QSB/273V5QSW: 35,57 W (typ.), 36,27 W (maks.)
273V5QSBP/273V5QSWP: 23,90 W (typ.), 24,58 W (maks.)

I dvale (Standby) 0,5W
Fra 0,5W
Strømdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)
Strømforsyning Indbygget, 100-240 VAC, 50/60 Hz
Mål
Produkt uden fod (B x H x D) 646× 471 × 240 mm
Produkt uden fod (B x H x D) 646 × 398 × 57 mm
Vægt
Produkt med fod 4,53kg
Produkt uden fod 4,00kg
Driftsforhold
Temperaturområde (drift) 0°C til 40°C
Temperaturområde
(Ikke drift) -20°C til 60°C

Relativ fugtighed 20% til 80%
MTBF 30.000 timer
Miljømæssige forhold
ROHS JA
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EPEAT Silver (www.epeat.net)
Emballage 100% genbrugelig
Energistjerne JA
Overholdelse og standarder

Myndighedernes godkendelser
CE-mærkning, FCC Klasse B, SEMKO, TCO-certificeret kant, 
ETL, ISO9241-307, EPA, BSMI, ukrainsk, CCC, CECP, PSB, WEEE, 
C-TICK, CU

Kabinet
Farve Sort/Hvid
Finish Blank/Struktur 

	 Bemærk
1.	 EPEAT Gold og Silver er kun gyldig, der hvor Philips registrere produktet. Besøg venligst www.epeat.

net for registreringsstatus i dit land.
2.	 Disse data kan ændres uden varsel. Gå til www.philips.com/support for at hente den seneste 

version af brochuren.
3.	 Smart Response er den optimale indstilling både på GtG og GtG (BW) test.

www.epeat.net
www.epeat.net
www.epeat.net
www.philips.com/support
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4.1	 Opløsning og forudindstillede 
funktioner

	 Maksimal opløsning
1920 x 1080 ved 60 Hz (analogt indgang)
1920 x 1080 ved 60 Hz (digital indgang)

	 Anbefalet opløsning
1920 x 1080 ved 60 Hz (digital indgang)

V frekv. 
(kHzx)

Opløsning L frekv. (Hz)

31,47 720 × 400 70,09
31,47 640 × 480 59,94
35,00 640 × 480 66,67
37,86 640 × 480 72,81
37,50 640 × 480 75,00
37,88 800 × 600 60,32
46,88 800 × 600 75,00
48,36 1024 × 768 60,00
60,02 1024 × 768 75,03
44,77 1280 × 720 59,86
63,89 1280 × 1024 60,02
79,98 1280 × 1024 75,03
55,94 1440 × 900 59,89
70,64 1440 × 900 74,98
65,29 1680 × 1050 59,95
67,50 1920 × 1080 60,00

	 Bemærk
Bemærk venligst, at din skærm virker bedst med 
native opløsning på 1920 X 1080 ved 60Hz. For 
at opnå den bedste skærmkvalitet, bedes du 
venligst bruge denne opløsning.
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5.	 Strømstyring
Hvis der er installeret et skærmkort eller 
software på pc’en, der er i overensstemmelse 
med VESA DPM, kan skærmen automatisk 
nedsætte strømforbruget, når den ikke bruges. 
Når input fra tastatur, mus eller anden input-
enhed registreres, "vågner" skærmen automatisk 
igen. Nedenstående tabel viser denne 
automatiske energisparefunktions strømforbrug 
og signalering:

273V5LSB/273V5LSW:
Energispare-definition

VESA 
tilstand Video V synk L synk Opbrugt strøm LED Farve 

Aktiv TIL Ja Ja 32,53 W (typ.)
33,95W (maks.) Hvid

I dvale 
(Standby) FRA Nej Nej  < 0,5W (typ.) Hvid 

(blinker)

Kontakt Fra FRA - -  < 0,5W (typ.) FRA

273V5QSB/273V5QSW:
Energispare-definition

VESA 
tilstand Video V synk L synk Opbrugt strøm LED Farve 

Aktiv TIL Ja Ja 35,57 W (typ.)
36,27W (maks.) Hvid

I dvale 
(Standby) FRA Nej Nej  < 0,5W (typ.) Hvid 

(blinker)

Kontakt Fra FRA - -  < 0,5W (typ.) FRA

73V5QSBP/273V5QSWP:
Energispare-definition

VESA 
tilstand Video V synk L synk Opbrugt strøm LED Farve 

Aktiv TIL Ja Ja 23,90 W (typ.)
24,58W (maks.) Hvid

I dvale 
(Standby) FRA Nej Nej  < 0,5W (typ.) Hvid 

(blinker)

Kontakt Fra FRA - -  < 0,5W (typ.) FRA

273V5LYAB:
Energispare-definition

VESA 
tilstand Video V synk L synk Opbrugt strøm LED Farve

Aktiv TIL Ja Ja 25,05W (typ.)
35,3W (maks.) Hvid

I dvale 
(Standby) FRA Nej Nej < 0,5W (typ.) Hvid 

(blinker)

Kontakt Fra FRA - -  < 0,5W (typ.) FRA

273V5LHSB:
Energispare-definition

VESA 
tilstand Video V synk L synk Opbrugt strøm LED Farve 

Aktiv TIL Ja Ja 29,1W (typ.)
34,26W (maks.) Hvid

I dvale 
(Standby) FRA Nej Nej < 0,5W (typ.) Hvid 

(blinker)

Kontakt Fra FRA - - < 0,3W (typ.) FRA

273V5QHAB:
Energispare-definition

VESA 
tilstand Video V synk L synk Opbrugt strøm LED Farve

Aktiv TIL Ja Ja 40,74W (typ.)
47,59W (maks.) Hvid

I dvale 
(Standby) FRA Nej Nej < 0,5W (typ.) Hvid 

(blinker)

Kontakt Fra FRA - -  < 0,3W (typ.) FRA

273V5QHABP:
Energispare-definition

VESA 
tilstand Video V synk L synk Opbrugt strøm LED Farve

Aktiv TIL Ja Ja 25,49W (typ.)
28,18W (maks.) Hvid

I dvale 
(Standby) FRA Nej Nej < 0,5W (typ.) Hvid 

(blinker)

Kontakt Fra FRA - -  < 0,3W (typ.) FRA

273V5LHAB:
Energispare-definition

VESA 
tilstand Video V synk L synk Opbrugt strøm LED Farve 

Aktiv TIL Ja Ja 27,19W (typ.)
34,84W (maks.) Hvid

I dvale 
(Standby) FRA Nej Nej < 0,5W (typ.) Hvid 

(blinker)

Kontakt Fra FRA - -  < 0,3W (typ.) FRA
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Følgende opsætning bruges til at måle skærmens 
strømforbrug.

•	 Indbygget opløsning: 1920 × 1080
•	 Kontrast: 50%
•	 Lysstyrke: 300 nit eller 200 nit 
•	 Farvetemperatur : 6500k med fuldt, hvidt 

mønster

	 Bemærk
Disse data kan ændres uden varsel.



23

6. Lovmæssige oplysninger

6.	 Lovmæssige oplysninger
Lead-free Product

Lead free display promotes environ-
mentally sound recovery and disposal 
of waste from electrical and electro-
nic equipment. Toxic substances like 

Lead has been eliminated and compliance with 
European community’s stringent RoHs directive 
mandating restrictions on hazardous substances 
in electrical and electronic equipment have been 
adhered to in order to make Philips monitors 
safe to use throughout its life cycle.

Congratulations!
This product is TCO Certified-for Sustainable IT

TCO Certified is an international third party 
sustainability certification for IT pro-
ducts. TCO Certified ensures that 
the manufacture, use and recycling 

of IT products reflect environmental, social and 
economic responsibility. Every TCO Certified 
product model is verified by an accredited inde-
pendent test laboratory. ​ 
This product has been verified to meet all the 
criteria in TCO Certified, including:

Corporate Social Responsibility 
Socially responsible production - working condi-
tions and labor law in manufacturing country

Energy Efficiency 
Energy efficiency of product and power supply. 
Energy Star compliant, where applicable 

Environmental Management System 
Manufacturer must be certified according to 
either ISO 14001 or EMAS

Minimization of Hazardous Substances 
Limits on cadmium, mercury, lead & hexavalent 
chromium including requirements for mercury-
free products, halogenated substances and 
hazardous flame retardants

Design for Recycling 
Coding of plastics for easy recycling. Limit on 
the number of different plastics used.

Product Lifetime, Product Take Back 
Minimum one-year product warranty. Minimum 
three-year availability of spare parts. Product 
takeback 

Packaging 
Limits on hazardous substances in product 
packaging. Packaging prepared for recycling

Ergonomic, User-centered design 
Visual ergonomics in products with a display. 
Adjustability for user comfort (displays, head-
sets) Acoustic performance – protection against 
sound spikes (headsets) and fan noise (pro-
jectors, computers) Ergonomically designed 
keyboard (notebooks)

Electrical Safety, minimal electro-magnetic 
Emissions Third Party Testing  
All certified product models have been tested 
in an independent, accredited laboratory.
A detailed criteria set is available for download 
at www.tcodevelopment.com, where you can 
also find a searchable database of all TCO Cer-
tified IT products.

TCO Development, the organization behind 
TCO Certified, has been an international 
driver in the field of Sustainable IT for 20 years. 
Criteria in TCO Certified are developed in 
collaboration with scientists, experts, users and 
manufacturers. Organizations around the world 
rely on TCO Certified as a tool to help them 
reach their sustainable IT goals. We are owned 
by TCO, a non-profit organization representing 
office workers. TCO Development is head-
quartered in Stockholm, Sweden, with regional 
presence in North America and Asia.

TCO Certified Document for Displays version. 
2.3.

"For displays with glossy bezels the user should 
consider the placement of the display as the 
bezel may cause disturbing reflections from sur-
rounding light and bright surfaces."

www.tcodevelopment.com
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For more information, please visit  
www.tcodevelopment.com

Technology for you and the planet

(Only for selective models)

EPEAT
(www.epeat.net)

The EPEAT (Electronic Pro-
duct Environmental Assess-
ment Tool) program evaluates 
computer desktops, laptops, 

and monitors based on 51 environmental crite-
ria developed through an extensive stakeholder 
consensus process supported by US EPA.

EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and select 
desktop computers, notebooks and monitors 
based on their environmental attributes. EPEAT 
also provides a clear and consistent set of per-
formance criteria for the design of products, and 
provides an opportunity for manufacturers to 
secure market recognition for efforts to reduce 
the environmental impact of its products.

Benefits of EPEAT
Reduce use of primary materials 
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 
ENERGY STAR’s energy efficiency specifications, 
means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity
This product is in conformity with the following 
standards 

•	 EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of 
Information Technology Equipment).

•	 EN55022:2010 (Radio Disturbance 
requirement of Information Technology 
Equipment).

•	 EN55024:2010 (Immunity requirement of 
Information Technology Equipment).

•	 EN61000-3-2:2006 +A1:2009+A2:2009 
(Limits for Harmonic Current Emission).

•	 EN61000-3-3:2008 (Limitation of Voltage 
Fluctuation and Flicker) following provisions 
of directives applicable.

•	 2006/95/EC (Low Voltage Directive).
•	 2004/108/EC (EMC Directive).
•	 2009/125/EC (ErP, Energy-related Product 

Directive, EC No. 1275/2008 and 642/2009 
Implementing) 

•	 2011/65/EU (RoHS Directive)
And is produced by a manufacturing organiza-
tion on ISO9000 level.

The product also comply with the following 
standards 

•	 ISO9241-307:2008 (Ergonomic 
requirement, Analysis and compliance test 
methods for electronic visual displays).

•	 GS EK1-2000:2013 (GS mark requirement).
•	 prEN50279:1998 (Low Frequency Electric 

and Magnetic fields for Visual Display).
•	 MPR-II (MPR:1990:8/1990:10 Low 

Frequency Electric and Magnetic fields).
•	 TCO CERTIFIED (Requirement for 

Environment Labeling of Ergonomics, 
Energy, Ecology and Emission, TCO: Swedish 
Confederation of Professional Employees) 
for TCO versions.

www.tcodevelopment.com
www.epeat.net
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Energy Star Declaration
(www.energystar.gov)

As an ENERGY STAR® Partner, we 
have determined that this product 
meets the ENERGY STAR® guideli-
nes for energy efficiency.

	 Note
We recommend you switch off the monitor 
when it is not in use for a long time.

Federal Communications Commission (FCC) 
Notice (U.S.  Only)

	 This equipment has been tested and found 
to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to pro-
vide reasonable protection against harmful 
interference in a residential installation. This 
equipment generates, uses and can radiate 
radio frequency energy and, if not installed 
and used in accordance with the instruc-
tions, may cause harmful interference to 
radio communications.  
 
However, there is no guarantee that interfe-
rence will not occur in a particular instal-
lation. If this equipment does cause harmful 
interference to radio or television reception, 
which can be determined by turning the 
equipment off and on, the user is encou-
raged to try to correct the interference by 
one or more of the following measures: 

•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the 

equipment and receiver.
•	 Connect the equipment into an outlet on 

a circuit different from that to which the 
receiver is connected.

•	 Consult the dealer or an experienced 
radio/TV technician for help.

	 Changes or modifications not expressly ap-
proved by the party responsible for com-
pliance could void the user's authority to 
operate the equipment.

Use only RF shielded cable that was supplied 
with the monitor when connecting this monitor 
to a computer device. 

To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to 
rain or excessive moisture. 

THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity
Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harm-
ful interference, and (2) this device must accept 
any interference received, including interference 
that may cause undesired operation. 

Commission Federale de la Communication 
(FCC Declaration)

	 Cet équipement a été testé et déclaré con-
forme auxlimites des appareils numériques 
de class B,aux termes de l'article 15 Des 
règles de la FCC. Ces limites sont conçues 
de façon à fourir une protection raisonnable 
contre les interférences nuisibles dans le 
cadre d'une installation résidentielle.  
 
CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est 
pas installé et utilisé selon les consignes 
données, peuvent causer des interférences 
nuisibles aux communications radio.  

www.energystar.gov
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Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une installa-
tion particulière. Si cet appareil est la cause 
d'interférences nuisibles pour la réception 
des signaux de radio ou de télévision, ce qui 
peut être décelé en fermant l'équipement, 
puis en le remettant en fonction, l'utilisateur 
pourrait essayer de corriger la situation en 
prenant les mesures suivantes:

•	 Réorienter ou déplacer l’antenne de 
réception.

•	 Augmenter la distance entre l’équipement 
et le récepteur.

•	 Brancher l’équipement sur un autre circuit 
que celui utilisé par le récepteur.

•	 Demander l’aide du marchand ou d’un 
technicien chevronné en radio/télévision.
	 Toutes modifications n'ayant pas reçu 
l'approbation des services compétents 
en matière de conformité est susceptible 
d'interdire à l'utilisateur l'usage du présent 
équipement.

N'utiliser que des câbles RF armés pour les con-
nections avec des ordinateurs ou périphériques. 

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA. 

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification 
Notice
The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so on) 
should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the equip-
ment is in compliance with the protection usage 
requirements of standards PN-93/T-42107 and 
PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL:  
SØRG VED PLACERINGEN FOR, AT NET-
LEDNINGENS STIK OG STIKKONTAKT ER 
NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS:  
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI IR-
ROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ DU 
PASSE PÅ AT KONTAKTENE FOR STØMTIL-
FØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)

Ergonomie Hinweis (nur Deutschland)
Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
Schäden durch Röntgenstrahlen" festgelegten 
Vorschriften. 

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
über die Bauart von Störstrahlern nach Anlage 
III ¤ 5 Abs. 4 der Röntgenverordnung erfüllt sind. 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß 

1.	 Reparaturen nur durch Fachpersonal 
durchgeführt werden. 

2.	 	nur original-Ersatzteile verwendet werden. 
3.	 	bei Ersatz der Bildröhre nur eine 

bauartgleiche eingebaut wird. 

Aus ergonomischen Gründen wird empfoh-
len, die Grundfarben Blau und Rot nicht auf 
dunklem Untergrund zu verwenden (schlechte 
Lesbarkeit und erhöhte Augenbelastung bei zu 
geringem Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder weni-
ger. 

	 ACHTUNG: BEIM AUFSTELLEN DIESES 
GERÄTES DARAUF ACHTEN, DAß NETZ-
STECKER UND NETZKABELANSCHLUß 
LEICHT ZUGÄNGLICH SIND. 
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Restriction on Hazardous Substances 
statement (India) 

This product complies with the “India E-waste 
Rule 2011” and prohibits use of lead, mercury, 
hexavalent chromium, polybrominated 
biphenyls or polybrominated diphenyl ethers 
in concentrations exceeding 0.1 weight % and 
0.01 weight % for cadmium, except for the 
exemptions set in Schedule 2 of the Rule.

E-Waste Declaration for India

This symbol on the product or on its packaging 
indicates that this product must not be 
disposed of with your other household waste. 
Instead it is your responsibility to dispose of 
your waste equipment by handing it over to 
a designated collection point for the recycling 
of waste electrical and electronic equipment . 
The separate collection and recycling of your 
waste equipment at the time of disposal will 
help to conserve natural resources and ensure 
that it is recycled in a manner that protects 
human health and the environ-ment. For more 
information about where you can drop off your 
waste equipment for recycling in India please 
visit the below web link.

http://www.india.philips.com/about/sustainability/
recycling/index.page

China RoHS 

The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products including CRT and Monitor 
which are produced and sold for China market 
have to meet China RoHS request.

中国大陆RoHS 
根据中国大陆《电子信息产品污染控制管理办法》（也
称为中国大陆RoHS），以下部分列出了本产品中可能
包含的有毒有害物质或元素的名称和含量

本表适用之产品 

显示器（液晶及CRT）

有毒有害物质或元素

部件名称
有毒有害物质或元素

铅
（Pb）

汞
（Hg）

镉
（Cd）

六价铬
（Cr6+）

多溴联苯
（PBB）

多溴二苯醚
（PBDE）

外壳 O O O O O O
CRT显示屏 X O O O O O

液晶显示屏/灯管 X O O O O O
电路板组件* X O O O O O
电源适配器 X O O O O O

电源线/连接线 X O O O O O
*:电路板组件包括印刷电路板及其构成的零部件，如电阻、电容、集成电

路、连接器等
O:表示该有毒有害物质在该部件所有均质材料中的含量均在 

GB/T26572-2011规定的限量要求以下
X:表示该有毒有害物质至少在该部件的某一均质材料中的含量超出 

GB/T26572-2011规定的限量要求；但是上表中打“×”的部件，符合欧
盟RoHS法规要求（属于豁免的部分）

 环保使用期限 

此标识指期限(十年),电子信息产品中含有的有毒有害物
质或元素在正常使用的条件下不会发生外泄或突变, 电
子信息产品用户使用该电子信息产品不会对环境造成严
重污染或对其人身、 财产造成严重损害的期限．

中国能源效率标识
根据中国大陆《能源效率标识管理办法》，本显示器符
合以下要求：

能源效率(cd/W) >1.05 

关闭状态(W) <0.5

能效等级 1级

能效标准 GB 21520-2008

详细有关信息请查阅中国能效标识网：
http://www.energylabel.gov.cn

《废弃电器电子产品回收处理管理条例》提示性
说明

为了更好地关爱及保护地球，当用户不再需要此产品或
产品寿命终止时，请遵守国家废弃电器电子产品回收处
理相关法律法规，将其交给当地具有国家认可的回收处
理资质的厂商进行回收处理。  

http://www.india.philips.com/about/sustainability/recycling/index.page
http://www.india.philips.com/about/sustainability/recycling/index.page
http://www.energylabel.gov.cn
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EU Energy Label

The European Energy Label informs you on 
the energy efficiency class of this product. 
The greener the energy efficiency class of this 
product is the lower the energy it consumes. 

On the label, you can find the energy efficiency 
class, the average power consumption of 
this product in use and the average energy 
consumption for 1 year. 

	 Note

The EU Energy Label will be ONLY applied on 
the models bundling with HDMI and TV tuners.
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7.	 Kundeservice og garanti

7.1	 Philips' regler ved pixeldefekter 
på fladskærme

Philips tilstræber at levere produkter af den højeste 
kvalitet. Vi anvender nogle af branchens mest 
avancerede produktionsprocesser og udfører 
en streng kvalitetskontrol. En gang imellem er 
defekte pixler eller sub-pixler på TFT-skærme dog 
uundgåelige. Ingen producent kan garantere, at alle 
paneler vil være fri for pixeldefekter, men Philips 
garanterer, at enhver skærm med et uacceptabelt 
antal defekter repareres eller udskiftes under 
garantien. Dette notat forklarer de forskellige 
former for pixeldefekter og definerer de acceptable 
defektniveauer for hver type. For at være berettiget 
til reparation eller udskiftning under garantien 
skal antallet af pixeldefekter på en TFT -skærm 
overskride disse acceptable niveauer. For eksempel 
må højst 0,0004% af sub-pixlerne på en skærm 
være defekte. Desuden sætter Philips endnu højere 
kvalitetsnormer på visse typer eller kombinationer 
af pixeldefekter, der er mere generende end andre. 
Denne pixelpolitik gælder i hele verden.

pixler

sub-pixler sub-pixler sub-pixler

Pixler og sub-pixler
En pixel eller et billedelement er sammensat af 
tre sub-pixler med primærfarverne rød, grøn og 
blå. Når mange pixler sættes sammen, kan de 
danne et billede. Når alle sub-pixler i en pixel 
lyser, fremstår de farvede sub-pixler tilsammen 
som enkelt hvid pixel. Hvis de alle er mørke, 
fremstår de tre farvede sub-pixler tilsammen 
som en enkelt sort pixel. Andre kombinationer 
af oplyste og mørke sub-pixler fremstår som 
enkelte pixler i andre farver.

Forskellige typer pixeldefekter
Pixel- og sub-pixeldefekter optræder på 
skærmen på forskellige måder. Der er to 
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker
Defekte lyse prikker (Bright Dot Defects) 
fremkommer som pixels eller underpixels, 
der altid lyser eller er "tændt". Det vil sige, at 
en lys prik er en underpixel, der fremstår på 
skærmbilledet, når skærmen viser et mørkt 
mønster. Der er følgende typer defekte lyse 
prikker.

En tændt rød, grøn eller blå sub-pixel.

To sammenliggende tændte sub-pixler :
-	 Rød + Blå = Lilla
-	 Rød + Grøn = Gul
-	 Grøn + Blå = Cyan (Lyseblå)

Tre sammenliggende tændte pixler (en hvid 
pixel).
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	 Bemærk
En rød eller blå lys prik skal være mere end 50 
procent lysere end de omkringliggende prikker, 
mens en grøn lys prik er 30 procent lysere end 
de omkringliggende prikker.

Defekte mørke prikker
Defekte mørke prikker (Black Dot Defects) 
fremkommer som pixels eller underpixels, der 
altid er mørke eller er "slukkede". Det vil sige, 
at en lys prik er en underpixel, der fremstår på 
skærmbilledet, når skærmen viser et mørkt mønster. 
Der er følgende typer defekte mørke prikker.

Tætsiddende pixeldefekter
Da pixel- og sub-pixeldefekter af samme 
type, der ligger tæt på hinanden, kan være 
mere iøjnefaldende, specificerer Philips også 
tolerancer for tætsiddende pixeldefekter.

Pixeldefekttolerancer
For at være berettiget til reparation eller 
udskiftning på grund af pixeldefekter i 
garantiperioden skal en TFT-skærm i en Philips 
fladskærm have pixel- eller sub-pixeldefekter, 
der overskrider de tolerancer, der er gengivet i 
følgende tabeller.

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU
1 tændt sub-pixel 3
2 sammenliggende tændte sub-pixler 1
3 sammenliggende tændte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3
BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU
1 mørk sub-pixel 5 eller færre
2 sammenliggende mørke sub-pixler 2 eller færre
3 sammenliggende mørke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller færre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller færre

	 Bemærk
1.	 1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
2.	 This monitor is ISO9241-307 compliant.(ISO9241-307: Testmetoder for ergonimiske krav, analyse 

og overensstemmelse på elektroniske visuelle skærme)
3.	 ISO9241-307 is the successor of formerly known ISO13406 standard, which is withdrawn by the 

International Organisation for Standardisation (ISO) per: 2008-11-13.
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7.2	 Kundeservice og garanti
For oplysninger om garantidækning og gældende støttekrav i dit område, bedes du besøge www.
philips.com/support website for details. Du kan også kontakte dit lokale Philips kundeservicecenter via 
nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land CSP Nummer til 
kundeservice Pris Åbningstider

Austria RTS +43 0810 000206 € 0,07 Mon to Fri : 9am - 6pm
Belgium Ecare +32 078 250851 € 0,06 Mon to Fri : 9am - 6pm
Cyprus Alman 800 92 256 Free of charge Mon to Fri : 9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff Mon to Fri : 9am - 6pm
Finland Infocare +358 09 2290 1908 Local call tariff Mon to Fri : 9am - 6pm
France Mainteq +33 082161 1658 € 0,09 Mon to Fri : 9am - 6pm
Germany RTS +49 01803 386 853 € 0,09 Mon to Fri : 9am - 6pm
Greece Alman +30 00800 3122 1223 Free of charge Mon to Fri : 9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff Mon to Fri : 8am - 5pm
Italy Anovo Italy +39 840 320 041 € 0,08 Mon to Fri : 9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff Mon to Fri : 9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0,10 Mon to Fri : 9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff Mon to Fri : 9am - 6pm
Poland MSI +48 0223491505 Local call tariff Mon to Fri : 9am - 6pm
Portugal Mainteq 800 780 902 Free of charge Mon to Fri : 8am - 5pm
Spain Mainteq +34 902 888 785 € 0,10 Mon to Fri : 9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff Mon to Fri : 9am - 6pm
Switzerland ANOVO CH +41 02 2310 2116 Local call tariff Mon to Fri : 9am - 6pm
United Kingdom Celestica +44 0207 949 0069 Local call tariff Mon to Fri : 8am - 5pm

www.philips.com/support
www.philips.com/support
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Kontaktoplysninger til CENTRAL- OG ØSTEUROPA:

Land Callcenter CSP Kundeservice tlf

Belarus N/A IBA +375 17 217 3386 
+375 17 217 3389

Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A MR Service Ltd +385 (01) 640 1111
Czech Rep. N/A Asupport 420 272 188 300

Estonia N/A FUJITSU +372 6519900(General) 
+372 6519972(workshop)

Georgia N/A Esabi +995 322 91 34 71

Hungary N/A Profi Service +36 1 814 8080(General) 
+36 1814 8565(For AOC&Philips only)

Kazakhstan N/A Classic Service I.I.c. +7 727 3097515

Latvia N/A ServiceNet LV +371 67460399
+371 27260399

Lithuania N/A UAB Servicenet +370 37 400160(general) 
+370 7400088 (for Philips)

Macedonia N/A AMC +389 2 3125097
Moldova N/A Comel +37322224035
Romania N/A Skin +40 21 2101969
Russia N/A CPS +7 (495) 645 6746
Serbia&Montenegro N/A Kim Tec d.o.o. +381 11 20 70 684
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC H.and +386 1 530 08 24
the republic of Belarus N/A ServiceBy + 375 17 284 0203
Turkey N/A Tecpro +90 212 444 4 832 

Ukraine
N/A Topaz +38044 525 64 95
N/A Comel +380 5627444225

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter Kundeservice tlf
Brazil

Vermont 
0800-7254101

Argentina 0800 3330 856

Kontaktoplysninger til Kina:

Land Callcenter Kundeservice tlf
China PCCW Limited 4008 800 008
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Kontaktoplysninger til NORDAMERIKA:

Land Callcenter Kundeservice tlf
U.S.A. EPI - e-center (877) 835-1838

Canada EPI - e-center (800) 479-6696

Kontaktoplysninger til APMEA:

Land ASP Kundeservice tlf Åbningstider

Australia AGOS NETWORK 
PTY LTD 1300 360 386 Mon.~Fri. 9:00am-5:30pm

New Zealand Visual Group Ltd. 0800 657447 Mon.~Fri. 8:30am-5:30pm

Hong Kong 
Macau

Company: Smart Pixels 
Technology Ltd.

Hong Kong: 
Tel: +852 2619 9639 
Macau: 
Tel: (853)-0800-987

Mon.~Fri. 9:00am-6:00pm  
Sat. 9:00am-1:00pm

India REDINGTON INDIA 
LTD

Tel: 1 800 425 6396 
SMS: PHILIPS to 56677 Mon.~Fri. 9:00am-5:30pm

Indonesia PT. CORMIC 
SERVISINDO PERKASA

+62-21-4080-9086 
(Customer Hotline) 
+62-8888-01-9086 
(Customer Hotline)

Mon.~Thu. 08:30-12:00; 13:00-
17:30  
Fri. 08:30-11:30; 13:00-17:30

Korea Alphascan Displays, Inc 1661-5003 Mon.~Fri. 9:00am-5:30pm 
Sat. 9:00am-1:00pm

Malaysia R-Logic Sdn Bhd +603 5102 3336 Mon.~Fri. 8:15am-5:00pm 
Sat. 8:30am-12:30am

Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm

Singapore
Philips Singapore Pte 
Ltd (Philips Consumer 
Care Center)

(65) 6882 3966 Mon.~Fri. 9:00am-6:00pm 
Sat. 9:00am-1:00pm

Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00

Thailand Axis Computer System 
Co., Ltd. (662) 934-5498 Mon.~Fri. 08:30am~05:30pm

South Africa Computer Repair 
Technologies 011  262 3586 Mon.~ Fri. 08:00am~05:00pm

Israel Eastronics LTD 1-800-567000 Sun.~Thu. 08:00-18:00 

Vietnam
FPT Service Informatic 
Company Ltd. - Ho Chi 
Minh City Branch

+84 8 38248007 
Ho Chi Minh City 
+84 5113.562666 
Danang City 
+84 5113.562666 
Can tho Province

Mon.~Fri. 8:00-12:00, 13:30-17:30 
Sat. 8:00-12:00
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Philippines EA Global Supply Chain 
Solutions ,Inc. (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm

Armenia 
Azerbaijan 
Georgia 
Kyrgyzstan 
Tajikistan

Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00

Uzbekistan Soniko Plus Private 
Enterprise Ltd +99871 2784650 Mon.~Fri. 09:00 - 18:00

Turkmenistan Technostar Service 
Centre +(99312) 460733, 460957 Mon.~Fri. 09:00 - 18:00

Japan フィリップスモニター
・サポートセンター 0120-060-530 Mon.~Fri. 10:00 - 17:00
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8.	 Fejlfinding og FAQ

8.1	 Fejlfinding
Denne side omhandler problemer, som kan 
klares af brugeren selv. Hvis problemet stadig er 
der, efter at du har prøvet disse løsninger, skal 
du kontakte Philips' kundeservice.

	 Almindelige problemer

Intet billede (strømdiode lyser ikke)
•	 Kontroller, at ledningen er sat i 

stikkontakten og bag på skærmen.
•	 Kontroller først, at strømkontakten foran 

på skærmen er i FRA, og stil den derefter 
på TIL.

Intet billede (strømdiode lyser hvid)
•	 Kontroller, at der er tændt for computeren.
•	 Kontroller, at signalkablet er korrekt 

forbundet til computeren.
•	 Kontroller, at der ikke er nogen bøjede 

stikben på signalkablets stik. Hvis der er det, 
skal du få kablet repareret eller udskiftet.

•	 Energisparefunktionen kan være aktiveret

Skærm siger

Attention

Check cable connection

•	 Kontroller, at signalkablet er korrekt 
forbundet til computeren. (Se også Quick 
Start Guiden).

•	 Tjek, om skærmkablets stikben er bøjede.
•	 Kontroller, at der er tændt for computeren.

AUTO (AUTOMATISK) knappen virker ikke
•	 Den Auto (Automatisk) funktion fungerer 

kun i VGA-Analog-tilstand. Hvis resultatet 
ikke er tilfredsstillende, kan der foretages 
manuelle justeringer via OSD-menuen.

	 Bemærk
Den Auto (Automatisk) funktion er ikke 
nødvendig i DVI-Digital-tilstand.

Synlige tegn på røg eller gnister
•	 Forsøg ikke selv at fejlfinde
•	 Træk straks skærmens stik ud af 

stikkontakten
•	 Kontakt straks en repræsentant fra Philips 

kundeafdeling.

	 Billedproblemer

Billedet er ikke centreret
•	 Justér billedets position med funktionen 

"Auto" (Automatisk) i OSD-menuerne.
•	 Juster billedpositionen med Phase/Clock 

(Fase/Klokke) i Setup (Opsætning) i OSD 
hovedmenuen. Den kan kun bruges i VGA-
tilstand.

Billede vibrerer på skærmen
•	 Tjek, at signalkablet er korrekt forbundet til 

grafikkortet eller pc'en.

Lodret flimren

•	 Justér billedet med funktionen "Auto" 
(Automatisk) i OSD-menuerne.

•	 Eliminer de lodrette bjælker med Phase/
Clock (Fase/Klokke) i Setup (Opsætning) i 
OSD hovedmenuen. Den kan kun bruges i 
VGA-tilstand.

Vandret flimren

•	 Justér billedet med funktionen "Auto" 
(Automatisk) i OSD-menuerne.

•	 Eliminer de lodrette bjælker med Phase/
Clock (Fase/Klokke) i Setup (Opsætning) i 
OSD hovedmenuen. Den kan kun bruges i 
VGA-tilstand.
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Billedet er sløret, uklart eller for mørkt
•	 Indstil kontrasten og lysstyrken i OSD.

Der forbliver et "efterbillede", 
"indbrændingsbillede" eller "spøgelsesbillede", 
efter at der er slukket for strømmen.
•	 Uafbrudt visning af stille eller statiske billeder 

over en længere periode kan forårsage, at 
billedet "brændes fast" på skærmen, dvs. de 
såkaldte "efterbilleder" eller "spøgelsesbilleder" 
på din skærm. "Fastbrænding", "efterbilleder" og 
"spøgelsesbilleder" er velkendte fænomener 
inden for LCD teknologien. I de fleste tilfælde 
vil "brandmærkerne" eller "efterbilledet" eller 
"spøgelsesbilledet" forsvinde gradvist, efter 
skærmen er blevet slukket.

•	 Sørg altid for at aktivere en pauseskærm, 
der bevæger sig, når skærmen efterlades 
uden at blive anvendt.

•	 Du skal altid bruge en pauseskærm eller 
et andet program, der opdaterer skærmen 
regelmæssigt, hvis LCD skærmen viser 
statisk materiale i længere perioder.

•	 Imidlertid forsvinder alvorligere tilfælde 
af "fastbrænding", "efterbilleder" og 
"spøgelsesbilleder" ikke og kan heller ikke 
fjernes ved reparation. Ovennævnte skader 
er ikke dækket af garantien.

Billedet er forvrænget.  Tekst er utydelig eller 
sløret.
•	 Indstil pc'ens skærmopløsning som 

skærmens anbefalede, native opløsning.

Der ses røde, blå, mørke og hvide pletter på 
skærmen
•	 De resterende prikker er normale i den 

flydende krystal-teknik, der bruges i dag. Se 
politikken om pixels for yderligere oplysninger.

"Tændt" lyset er for kraftigt, og det er 
forstyrrende
•	 Du kan justere "Tændt" lyset med 

Strømdiode i OSD-menuerne.
For yderligere hjælp, se venligst listen over 
Forbrugerinformationscentre og kontakt Philips's 
Kundeservice.

8.2	 Generelle FAQ

SP1:	 Hvad skal jeg gøre, hvis skærmen under 
installationen viser "Cannot display 
this video mode" (Kan ikke vise denne 
videotilstand)?

Sv.:	 Den anbefalede opløsning på denne 
skærm: 1920 x 1080 ved 60 Hz.

•	 Frakobl alle kabler og forbind derefter 
pc'en til skærmen, som du brugte før.

•	 I Windows Start menuen, vælg Settings/
Control Panel (Indstillinger/Kontrolpanel). 
I Kontrolpanel-vinduet vælg Display 
(Skærm)-ikonet. I Display (Skærm) 
Kontrolpanel vinduet, skal du vælge 
"Settings" (Indstillinger) fanebladet. Under 
indstillinger-fanen, under feltet "Desktop 
Area" (Skrivebordsområde), skal du stille 
justeringsbjælken på 1920 x 1080 pixler.

•	 Åbn "Advanced Properties" (Avanceret 
egenskaber) og stil Refresh Rate 
(Opdateringshastigheden) på 60 Hz og klik 
derefter på OK.

•	 Genstart computeren og gentag trinene 
2 og 3 og bekræft, at pc'en er indstillet til 
1920 x 1080 ved 60 Hz.

•	 Luk for computeren, frakobl den gamle 
skærm og genforbind Philips LCD skærmen.

•	 Tænd for skærmen og derefter for pc'en.

SP2:	 Hvad er den anbefalede 
opdateringshastighed på LCD skærmen?

Sv.:	 Den anbefalede opdateringshastighed 
på LCD skærme er 60 Hz. I tilfælde af 
forstyrrelser på skærmen skal du sætte 
den op til 75 Hz og se, om dette fjerner 
forstyrrelserne.

SP3:	 Hvad er .inf og .icm filerne på cd-rom'en?  
Hvordan installerer jeg driverne (.inf og .icm)?

Sv.:	 Dette er skærmens driverfiler. Installer 
driverne i henhold til brugervejledningen. 
Computeren kan bede dig om 
skærmdrivere (.inf og .icm filer) eller om 
en driverdisk, når du installerer skærmen 
første gang. Indsæt (medfølgende cd-
rom) i pakken i henhold til vejledningerne. 
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Skærmdrivere (.inf og .icm filer) installeres 
automatisk.

SP4:	 Hvordan justerer jeg opløsningen?
Sv.:	 Skærmkortet/grafikdriveren og skærmen 

bestemmer sammen opløsningerne til rådighed. 
Du kan vælge den ønskede opløsning under 
"Display properties" (Egenskaber for Skærm) i 
Windows® Control Panel (Kontrolpanel).

SP5:	 Hvad, hvis jeg farer vild, mens jeg 
justerer skærmen?

Sv.:	 Så skal du blot trykke på OK og derefter 
vælge "Reset" (Nulstil) for at gå tilbage til 
de oprindelige fabriksindstillinger.

SP6:	 Er LCD-skærmen modstandsdygtig 
overfor ridser?

Sv.:	 Det anbefales generelt ikke at udsætte 
skærmens overflade for kraftige stød. Den 
er beskyttet mod skarpe og stumpe ting. 
Når du håndterer skærmen, så pas på ikke 
at trykke for kraftigt på skærmens overflade. 
Det kan påvirke garantibetingelserne.

SP7:	 Hvordan rengør jeg LCD skærmens 
overflade?

Sv.:	 Til normal rengøring skal du blot anvende 
en ren, blød klud. Til kraftigere rengøring 
skal du bruge isopropylalkohol. Brug 
ikke andre opløsningsmidler såsom 
ethylalkohol, ethanol, acetone, hexan osv.

SP8:  	Kan jeg ændre skærmens farveindstilling?
Sv.:	 Ja, du kan ændre farveindstillingen via 

skærmmenuen på følgende måde:
•	 Tryk på "OK" for at vise skærmmenuen
•	 Tryk på "Down Arrow" (Ned-pil) for 

at vælge indstillingen "Color" (Farve), 
og tryk derefter på "OK" for at angive 
farveindstillingen. Der er tre indstillinger, 
som vist nedenfor.
1.	 Color Temperature (Farvetemperatur): 

de seks indstillinger er 6500K and 
9300K. Med indstillinger i 6500K 
området virker skærmen "varm" med 
en rød-hvid farvetone, mens en 9300K 
temperatur giver en "kold" blå-hvid 
farvetone.

2.	 sRGB: dette er en standardindstilling, 
som sikrer korrekt udveksling af farver 
mellem forskellige enheder (f.eks. 
digitale kameraer, skærme printere, 
skannere osv).

3.	 User Define (Brugerdefineret): brugeren 
kan vælge sin foretrukne farveindstilling 
ved at indstille den røde, grønne og blå 
farve.

	 Bemærk
En målning af farven på lys, der udstråles fra 
et objekt, mens det opvarmes. Denne måling 
udtrykkes på en absolut skala (kelvingrader). 
Lavere kelvingrader såsom 2004K er røde, 
højere temperaturer såsom 9300K er blå. 
Neutral temperatur, 6504K, er hvid.

SP9:	 Kan jeg forbinde min LCD skærm til 
enhver pc, arbejdsstation eller Mac?

Sv.:	 Ja. Alle Philips LCD skærme er fuldt 
kompatible med standard pc'er, Mac og 
arbejdsstationer. En ledningsadapter kan 
være nødvendig for at kunne forbinde 
skærmen til dit Mac-system. Vi anbefaler, at 
du kontakter Philips salgsrepræsentant for 
yderligere oplysninger.

SP10:	Er Philips LCD skærme "Plug & Play"?
Sv.:	 Ja, skærmene er "Plug & Play" kompatible 

med Windows® 7, 98, 2000, XP, Vista og 
Linux.

SP11:	Hvad er Billedklæbning eller 
Fastbrænding og Indbrændingsbillede 
eller Spøgelsesbillede på LCD skærme?

Sv.:	 Uafbrudt visning af stille eller statiske 
billeder over en længere periode 
kan forårsage, at billedet "brændes 
fast" på skærmen, dvs. de såkaldte 
"efterbilleder" og "spøgelsesbilleder" på 
din skærm. "Fastbrænding", "efterbilleder" 
og "spøgelsesbilleder" er velkendte 
fænomener inden for LCD teknologien. 
"Fastbrænding", "efterbilleder" og 
"spøgelsesbilleder" forsvinder oftest 
gradvist efter en vis periode, efter 
skærmen er slukket.
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Sørg altid for at aktivere en pauseskærm, 
der bevæger sig, når skærmen efterlades 
uden at blive anvendt.
Du skal altid bruge en pauseskærm eller 
et andet program, der opdaterer skærmen 
regelmæssigt, hvis LCD skærmen viser 
statisk materiale i længere perioder.

	 Advarsel
Hvis der ikke bruges en pauseskærm eller et 
program, der opdaterer skærmen periodisk, kan 
der opstå alvorlige tilfælde af "fastbrændinger" 
eller "efterbilleder" eller "spøgelsesbilleder", som 
ikke forsvinder, og som heller ikke kan repareres.  
Ovennævnte skade er ikke dækket af garantien.

SP12:	Hvorfor viser skærmen ikke skarp tekst? 
Hvorfor viser den forrevne tegn?

Sv.:	 Din LCD monitor virker bedst på dens 
native opløsning på 1920 x 1080 ved 60 
Hz. Brug denne opløsning for at opnå det 
bedste billede.
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